Read Me

Pro Tools 11.0.2 and Pro Tools HD 11.0.2 on

Mac OS X 10.8.x

This Read Me documents important compatibility information, resolved and known issues for Pro Tools® 11.0.2 and
Pro Tools HD® 11.0.2 software on computers running Mac OS X 10.8.x (“Mountain Lion”).

Issues Resolved in Pro Tools 11.0.2
User-Reported Issues
If Pro Tools 11 quits unexpectedly, it automatically creates a Crash Log report that you can submit to Avid. By submitting the report,
you can help us identify and address the issue. In the Comments section of the dialog that appears, describe the nature of the session you
were working on and the action or command that you were carrying out just before the issue occurred, then click “Send to Avid.” The
issues below were identified and addressed using these reports.
Pro Tools no longer quits unexpectedly when trying to modify the ALL Group. (PTSW-184989)
Pro Tools no longer quits unexpectedly when a VCA window is open and Preferences dialog is opened and closed.
(PTSW-185798)
Eleven Rack rigs can now be loaded from Pro Tools. (PTSW-185410, PTSW-184975, PTSW-184982)
Pro Tools no longer quits unexpectedly while AudioSuite previewing with the Shift parameter adjusted to edge values.
(PTSW-185758)
Pro Tools no longer quits unexpectedly when playing a surround track with dense automation. (PTSW-185399)
Pro Tools no longer quits unexpectedly during offline bounce when a plug-in exists on an unvoiced track. (PTSW-185425)
Pro Tools no longer quits unexpectedly during offline bounce when signal routes back through the same mixer. (PTSW-185482)
Pro Tools no longer quits unexpectedly when indexing particular SDII files. (PTSW-185452)
Pro Tools no longer quits unexpectedly while re-linking missing audio files. (PTSW-185111)
Fixed infinite loop of error dialog “IO channel count for current playback device has changed. Please restart Pro Tools” when
RME HDSPe MADI FX is the declared Playback Engine. (PTSW-185010)
Pro Tools no longer quits unexpectedly while searching in Help after connecting to SoundCloud. (PTSW-185014)
Pro Tools no longer quits unexpectedly on exit when running on an Open Directory Local Network user account in certain
configurations. (PTSW-185886)
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Recording
Audio recorded to tracks to the right of playback tracks is properly placed on the timeline. (PTSW-185778)
Destructive Punch records properly when the previous record pass extended past the end of the prepared audio.
(PTSW-177550)
Destructive Punch recording can be stopped in all situations. (PTSW-185339)
When recording to a track with an output assigned to a sub-stem of a main stem and with no tracks are assigned to the main
stem, Delay Compensation errors no longer occur. (PTSW-186092)

Editing
Performance is improved when using the Automation “Write to End” command across many tracks. (PTSW-186229)
When the Session Start Time is not 00:00:00:00, spotting a file to a new track after an offline bounce now works properly.
(PTSW-185380)
User Time Stamp values are now entered correctly in the Clip List. (PTSW-186373)

Mixing
On Pro Tools|HDX systems, post-fader sends following a Native plug-in no longer consume an extra voice. (PTSW-184939)
Sends now work correctly with Preview mode. (PTSW-186227)

Plug-Ins
The Time Compression/Expansion AAX plug-in is included with Pro Tools 11.0.2.
D-Verb DSP AAX controls have been fixed. (PTSW-186175)

Video
Correct frames are now pasted to a track when the copied movie's true frame rate is less than the Video Project Type.
(PTSW-184987)
Enabling and disabling video hardware during scrub now work properly with third-party video hardware. (UME-856)
Black Magic hardware now locates correctly after stop if Insertion Follows Playback is disabled. (UME-867)
Video track settings are now available after reopening a session with video. (PTSW-184691)
The Avid Video Engine no longer encounters video synchronization errors when playing beyond the 12-hour mark on the
timeline. (UME-906)
Video playback in Pro Tools no longer shows color deviation from playback in QuickTime player. (UME-823)

Workspace
The Workspace “Copy & Relink” function now works correctly. (PTSW-185803)
In the Workspace, Option-revealing a folder exposes or hides all nested subfolders. (PTSW-182561)
The “T” label (for Transfer volumes) now appears correctly when changing permissions in the Workspace. (PTSW-185355)
Pro Tools no longer stops working when dragging files from the Workspace with Tempo Match enabled. (PTSW-185442)

Bounce to Disk
MIDI events now play in order during an offline bounce. (PTSW-185058)
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Offline bounce with automation is now phase-accurate when compared to a bussed re-record. (PTSW-179224)

Issues Resolved in Pro Tools 11.0.1
The ReVibe II plug-in is now available with support for Pro Tools 11.0.1 (and higher) and Pro Tools 10.3.6 (PTSW-184681,
PTSW-183157)
Certain third-party plug-ins no longer cause your computer to stop working when quitting Pro Tools (PTSW-185005)

Compatibility
Avid can only assure compatibility and provide support for qualified hardware and software configurations.
For the latest compatibility information—including qualified computers, operating systems, and third-party products—visit the
Avid website (www.avid.com/compatibility).

iLok USB Key (2nd Generation) and Pro Tools Authorization
An iLok (2nd generation) must be connected at all times while running Pro Tools

Pro Tools requires that an iLok (2nd generation) with the appropriate authorizations be connected to the computer at all times. Do not
remove the iLok while running Pro Tools. If the iLok is removed while Pro Tools is running, one of the following will occur:
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click Save. Pro Tools saves the session and then quits.
• Click Quit. Pro Tools closes the session without saving and then quits.
– or –
Pro Tools displays a dialog giving you the following choices:
• Reinsert the iLok and click OK to continue working in Pro Tools.
• Click Cancel. Pro Tools closes the session without saving and then quits.

Co-Installing Pro Tools 10 and Pro Tools 11
Pro Tools 10.3.6 is the first version of Pro Tools 10 that supports installation on the same system with Pro Tools 11. Co-installation
support is limited to MacOS X 10.8 (“Mountain Lion”).
If you have an earlier version of Pro Tools installed, it is recommended that you perform a clean uninstall before installing Pro Tools
10.3.6 and Pro Tools 11.

To support co-installation of Pro Tools 10 and 11, a Pro Tools application alias is no longer added to the Dock during installation.
To add aliases for each Pro Tools application to the dock, do the following:
1

Select the Pro Tools application and choose File > Make Alias.

2

Rename the alias (for example, “Pro Tools 10” or “Pro Tools 11”).

3

Drag the renamed alias to the Dock.

General Compatibility
Pro Tools 11 does not support video capture (PTSW-181456)

Pro Tools 11 does not have the ability to record video to the timeline. Co-install Pro Tools 10.3.6 (or higher) on the same system and
use an Avid Mojo SDI to record video into Pro Tools 10. The captured video can then be used in Pro Tools 11.
Pro Tools 11 does not allow import of WMA files (PTSW-181506)
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If you attempt to import a WMA file into a Pro Tools 11 session, Pro Tools cannot convert the file and posts a “file is unreadable”
message. Co-install Pro Tools 10.3.6 (or higher) on the same system, import the WMA file, and convert it to a format supported by
Pro Tools 11.
QuickTime Player is not currently compatible with Avid Audio Interfaces on Mac OS X 10.8 (PTSW-163965)

QuickTime Player does not currently support Avid audio devices as output devices with Mac OS X 10.8. Audio will not pass through
and playback will not start. Please use an alternate audio interface for QuickTime Player, or use another software solution for playing
back QuickTime files with Avid audio devices as a workaround for this issue.
Pro Tools 11 sessions that use more than 4 gigabytes of RAM will cause Pro Tools 10 or lower to quit unexpectedly
(PTSW-181963)

If you attempt to open a Pro Tools 11 session that uses more than 4 gigabytes of RAM in Pro Tools 10 or lower, Pro Tools will quit unexpectedly. To open such sessions in Pro Tools 10 or lower, first reduce the amount of session RAM usage to less than 4 gigabytes in
Pro Tools 11 by removing virtual instruments that take up system memory.
Pro Tools cannot record to drives formatted as Case-Sensitive (PTSW-64502)

Pro Tools cannot record to Mac OS X drives which have been formatted as “Case-Sensitive.” Format the Mac OS X record volumes as
“Mac OS X Extended (Journaled)” in order to record properly.
Mac OS X keyboard shortcuts for Mission Control conflict with Pro Tools keyboard shortcuts

By default, Mac OS X uses Control + Arrow keys to open Mission Control and Application Windows. These keyboard shortcuts conflict
with the Pro Tools keyboard shortcuts for changing track display height. You can disable or reassign these shortcuts in Mac OS X.
To disable or reassign keyboard shortcuts in Mac OS X:
1

From the Apple menu, choose System Preferences.

2

Click Keyboard.

3

Click the Keyboard Shortcuts tab.

4

Disable or reassign the shortcut for Mission Control.

Library folder hidden in each User folder

DigiTrace logs, which can be helpful in troubleshooting Pro Tools errors, are stored in User/Library. These logs will be more difficult
to find if the Library folder is hidden.
To find the Library folder:


Go to the Finder and click the Go menu while holding the Option key. Library will appear in the menu while the Option key is held.

To display all hidden files and folders in an Open dialog:


Press Command+Shift.

To permanently unhide the Library folder:
1

Launch Terminal.

2

Type: chflags nohidden /Users/<Username>/Library.
The hide status of the Library folder may be reset during an OS update.

Enable Spotlight for best performance when relinking files and indexing in the Workspace (PTSW-183818)

For best performance with relinking and Workspace indexing, enable Spotlight. While enabling Spotlight is not required, it will improve
performance in this area with Pro Tools.
When Spotlight is enabled, long record passes (over 50 minutes) may stop recordings after 50+ minutes. Consider disabling Spotlight
for long recording sessions and then re-enable it when you are done recording.
Pro Tools menus and interface are grayed out on launch (PTSW-18024)
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Pro Tools can appear unresponsive at launch, with the menus grayed out and browsers inoperable. This can happen because of Spaces.
If Pro Tools is launched in any other Space than the first one, the Session Quick Start dialog still opens in the first Space. You can temporarily disable Spaces, launch Pro Tools, and disable the Session Quick Start dialog in the Preferences to avoid this problem.
OMF files that contain video are not compatible with Pro Tools 11 (PTSW-184397)

OMF sequences that contain video cannot be imported into Pro Tools 11. OMF sequences that contain embedded or referenced audio
files can be imported into Pro Tools 11. To import a sequence that contains video media, use a linked AAF sequence.
Pro Tools session file formats version 4.x and lower are not supported in Pro Tools 11 and higher (PTSW-181049)

Pro Tools session files from Pro Tools versions 4.x and lower are not recognized in Pro Tools 11 and higher. In the Pro Tools Workspace, these files are listed as “unknown,” and cannot be opened. Co-install Pro Tools 10.3.6 (or higher) on the same system and open
the session files in Pro Tools 10. Save the session in the current Pro Tools session format, then open the session in Pro Tools 11.
Automatic Update Notification will not connect through a proxy server that requires authentication (108837)

Software Updater will not find an active internet connection when behind a proxy server that requires authentication to gain internet access. To work around this, the client machine with Software Updater needs to be moved out from behind the proxy or the proxy needs
to allow HTTP access via port 80 without requiring authentication.
Ethernet control surfaces may be unable to communicate with Pro Tools when Parallels Desktop for Mac is installed (101232)

If you use an Ethernet control surface (such as C|24, D-Control or D-Command) with Pro Tools, Parallels Desktop for Mac may prevent
communication with the surface. Uninstall Parallels for your computer to restore communication.
Gatekeeper disallows installation of AvidCodecPE.pkg from the Pro Tools disk image (PTSW-184602)

Attempting to run the AvidCodecPE.pkg from the Pro Tools Installation disk image results in a warning from Gatekeeper that “AvidCodecsPE.pkg” cannot be opened. You can avoid this issue by enabling the “Allow applications from: Anywhere” in the Security & Privacy settings in the Mac System Preferences. Once you have installed Avid CODEC PE, you can reset your security settings.

Pro Tools|HDX Systems
Some Mac Pro computers with certain video cards may not have power connections available for HDX cards (PTSW-156545)

Some video cards require power from the motherboard, which is also a requirement for Avid HDX cards. If you have a video card that
requires both power connections on the motherboard, a power connection for your HDX cards will not be available. To avoid this problem, use a video card that does not require more than one power connection to the motherboard.

Pro Tools|HD Native PCIe Systems
With Mac OS 10.6.8 or higher, it may not be possible to update the firmware on an HD Native PCIe card (PTSW-146374)

When launching Pro Tools HD with a HD Native card on Mac OS 10.6.8 or higher, a –1164 error may occur. This error indicates that
the firmware for the HD Native card cannot be updated from version 1.0 to version 1.02 or 1.03. If this error occurs, you can only update
the firmware using Mac OS X 10.6.7 or lower. The firmware update can also fail when using a Thunderbolt MacBook Pro. To avoid this
error, use a Mac without Thunderbolt and use the Avid NativeCardFlasher utility to update the HD Native firmware,
For more information on updating Native card firmware, refer to the following Avid Knowledge Base articles:
http://avid.force.com/pkb/articles/en_US/troubleshooting/en419331
http://avid.force.com/pkb/articles/en_US/troubleshooting/en429831

Eleven Rack
Eleven Rack Guitar Window not available in Pro Tools 11 (PTSW-184398)

Pro Tools 11 does not provide the Guitar Window for Eleven Rack that is available in lower versions of Pro Tools.

Pro Tools 11.0.2 and Pro Tools HD 11.0.2 on Mac OS X 10.8.x — 9/11/13

5

VENUE
Restarting a VENUE console, including the changing of system configurations, leads to an audio interface timeout with a
connected Pro Tools|HD Native system (PTSW-183745)

When connecting a Pro Tools|HD Native system (PCIe or Thunderbolt) to a VENUE live sound system, VENUE HDx cards acting as
your interface to Pro Tools timeout when restarting the VENUE console. This includes changing the VENUE system input configuration between stage and HDx sources (Virtual Soundcheck). After timing out, Pro Tools cannot record or playback until you quit and relaunch Pro Tools.

Known Issues
The following sections document known issues you may encounter when using Pro Tools 11 and Pro Tools HD 11, along with
workarounds if they exist.

General Pro Tools Issues
Graphic artifacts may appear after creating a new session on some MacBooks (PTSW-179268)

If you encounter graphic artifacts after creating a new session in Pro Tools 11 on a MacBook, try closing and re-opening windows in
Pro Tools. To avoid this issue, disable Automatic Graphics Switching.
Synchronizing to external clock with a different sample rate from the session results in the following error: “The current
playback engine does not support a sample rate of 44.1 kHz” (PTSW-127065)

In certain circumstances, attempting to synchronize to an external clock that has a different sample rate than the session may result in
the following error: “The current playback engine does not support a sample rate of 44.1 kHz.” On Mac OS X, this may be preceded by
the error “Pro Tools has re-set the sample rate of the HW device because it was changed by another application.” If this happens, correct
the sample rate mismatch and re-select the correct clock rate.
Turning on Firewall causes a network access message when launching Pro Tools (PTSW-181756)

If you enable the Firewall in the Security & Privacy System Preferences, Mac OS X posts a message asking if Pro Tools should allow
incoming network connections every time you launch Pro Tools. If you manually add Pro Tools to the “allowed incoming connection”
list in Firewall Options, the message may not appear on launch, but in some cases, this setting does not persist. This scenario can be
avoided by turning off the Firewall.
More than one Catalog with the same name can be created (PTSW-183432)

From the Workspace, you can create more than one Catalog with the same name by right-clicking on any folder and selecting “Create
Catalog from Selection.” To avoid this, create Catalogs by right-clicking “Catalog” and choosing “New Catalog” in the Location pane;
this method prevents duplicate names. If more than one catalog with the same name is created, rename the catalogs.
The Pro Tools System Usage window displays spikes in CPU usage (PTSW-182238)

On older, slower computers, Pro Tools may display spikes in CPU usage at low Hardware Buffer Size settings (such as 32 or 64 samples). To avoid this issue, increase the Hardware Buffer Size in the Playback Engine dialog (Setup > Playback Engine). You can also
try setting the Default Through Instrument option to None in Pro Tools MIDI preferences (Setup > Preferences > MIDI).
Export Clip Definitions keyboard shortcut does not work (PTSW-180985)

The Export Clip Definitions keyboard shortcut (Shift + Command + Y) in Pro Tools conflicts with a MacOS keyboard shortcut. To remove the conflicting MacOS keyboard shortcut, go to System Preferences > Keyboard and click Keyboard Shortcuts. Select “Services”
and deselect “Make New Sticky Note.”
When Bouncing to Disk or Bouncing to QuickTime, the Bounce hangs if the file name contains an illegal character-such as “:”
or “ü” (PTSW-183327)

To avoid this issue, do not use non-standard characters for bounced file names.
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A Workspace search entry of a quotation mark followed by a space results in a search error (PTSW-183098)

In the Pro Tools Workspace, a quotation mark (“) followed by a space is an unsupported text combination for a search query, and will
yield a search error. Re-enter search query without the space.
Session Notes dialog frequently appears when opening sessions (PTSW-163563)

The Session Notes dialog frequently appears when opening sessions, but only reports that some paths are unavailable. You should be
able dismiss the dialog and playback the session without incident, but you may want to check your I/O Setup to insure that only valid
paths are configured.
Opening sessions created with Pro Tools 7.4 or lower (106746)

When opening sessions created with Pro Tools 7.4 or lower in Pro Tools 8.1 and higher, all waveform overviews are recalculated. This
is because Pro Tools now features 16-bit waveform overviews, so all old 8-bit overviews will need to be recalculated. This recalculation
only needs to happen once.
Using the Save Copy In command from Pro Tools 10 or higher (.ptx) to Pro Tools 9 and lower session formats cannot link to
audio files with names including certain characters (PTSW-163844)

In sessions containing tracks or files with special keyboard characters—such as “$,” “%,” or “#”—using the Save Copy In command to
save to Pro Tools legacy formats is not supported and may result in problems copying files. To avoid this issue, rename any tracks or
audio files containing special keyboard characters before saving a session in a legacy format.
Clip Groups can be dragged to tracks in Playlist view even though Clip Groups are not supported in Playlist view
(PTSW-152707)

It is possible to drag a clip group to a track in Playlist view even though clip groups are not supported in Playlist view. Normally, when
switching to Playlist view from another track view, any clip groups on that track are automatically ungrouped. While clip groups
dragged to tracks in Playlist view may appear to work properly, it is recommended that you ungroup them while in Playlist view to ensure proper behavior.
When importing session data, automation is replaced instead of overlaid when using Adjust Session Start Time to Match
Source Start Time (PTSW-149273)

Automation can sometimes be replaced instead of overlaid when using Adjust Session Start Time to Match Source Start Time when importing session data. This issue may occur if the source session start time (of the session being imported) is earlier than the current session start time. This issue can be avoided if you instead import the session data from the session with the later start time into the session
with the earlier start time. You must also not enable the Adjust Session Start Time to Match Source Start Time option, and select Maintain Absolute when prompted.
Automatic Delay Compensation cannot not be applied to tracks recording from different types of sources (PTSW-157960)

Automatic Delay Compensation cannot compensate for cascaded records that use both I/O and bus inputs to recording tracks. An example of this is feeding an audio track (in record) from an audio input, and then bussing the output of the track to another audio track
also in record. The first audio track will be compensated but the second cascaded track will not be. (This is not a common workflow.)
Audio scrubbing is offset by the overall system delay when Automatic Delay Compensation is enabled (PTSW-150138)

With Automation Delay Compensation enabled, when scrubbing audio the output is offset by the overall system delay (displayed in the
Session Setup Window). Large system delays cause a noticeable offset. To avoid this issue, you can disable Automatic Delay Compensation when you want to scrub audio for editing.
DestructivePunch may not behave correctly when using Automatic Delay Compensation (PTSW-157282)

When using the Maximum amount of Delay Compensation, DestructivePunch may not behave correctly. To avoid this issue, do not use
DestructivePunch with system delays over 4,096 samples at 48 kHz, 8,192 samples at 96 kHz, or 16,384 samples at 192 kHz.
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Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a different tempo
(PTSW-34086)

Audio clips on tick-based tracks do not play at the correct tempo after opening a Reason song with a tempo that is different from the one
in your session. To correct this, make any tempo change via the Conductor track or the Manual Tempo input and the clips will play back
correctly.
Cannot run Reason or Record as ReWire clients if they have not first been launched and set up as a standalone application
(PTSW-133070)

Reason and Record need to be launched and setup as a stand-alone applications before running them as a ReWire clients with Pro Tools.
Do the following:
• Launch Reason or Record in stand-alone mode and follow the on-screen instructions.
• Quit Reason or Record.
• Launch Pro Tools and insert Reason or Record as a ReWire plug-in on an audio, Auxiliary Input, or Instrument track.
Exporting interleaved BWF files from Pro Tools 10 and importing into Pro Tools 9.0.x and lower may cause Pro Tools to quit
unexpectedly (PTSW-151579)

When exporting any greater-than-stereo multichannel interleaved WAV (BWF) files other than 5.1 from Pro Tools 10 and then importing them into Pro Tools 9.x or lower, Pro Tools quits unexpectedly. To avoid this problem, export audio files for import into lower versions of Pro Tools in another file format (such as AIFF or multi-mono).
Opening a session with a QuickTime movie as a non-administrator user can prevent the movie from playing back (47053)

If you open a session as a non-administrator user and you do not have permissions for the QuickTime movie file, Pro Tools will tell you
that the movie file cannot be found and prompt you to relink. In the relink window the movie can be found and Pro Tools will appear
to relink to it but it will still not play back. For correct playback, make sure you have permission to use the QuickTime movie file.
AAF files that contain AMA-linked audio cannot be imported (PTSW-182322)

Pro Tools cannot import AAF files that contain AMA-linked audio files. AMA-linked audio must be imported or transcoded in Media
Composer before the AAF is exported.
Unrendered mix and match AAFs will not properly import (PTSW-181825)

If the error “A video file and its associated clips were removed because its timecode rate is incompatible with the project type” appears,
it is likely that your AAF contains unrendered mix and match video. To avoid this, render mix and match AAFs from Media Composer
before or during export.
48 kHz Bounce to MP3 in Pro Tools 7.x and higher results in a 44.1 kHz MP3 File (72617)

Bouncing to MP3 while using the “Highest Quality Encoding, Slower Encoding Time” setting with any bit rate other than 320 kbps will
result in a 44.1 kHz file. This is a known limitation of the encoder.

Pro Tools|HDX Systems
Pro Tools does not play back when an invalid sync source is selected on SYNC HD (Word Clock or AES/EBU) (PTSW-156651)

When attempting to initiate playback, playback will fail if a SYNC HD is connected to an HDX card and an Avid audio interface with
no connections to either the word clock or AES/EBU ports. Ensure that the clock is set to a working clock source to resolve this issue.
In Avid DigiTest, the reported slot number may not correspond to the physical slot number in the computer (PTSW-155373)

In Avid DigiTest, the slot number reported for Avid HDX cards starts from 0 on up. For example, “Slot 1” does not necessarily correlate
to the first physical slot in the machine. If you have an Avid HDX card that is having problems, match the Serial Number ID on the back
of the card with the Serial Number ID displayed on the Slot Info page in Avid DigiTest.
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Pro Tools does not use HDX hardware if a Core Audio application is using HDX hardware (PTSW-155010)

When launching Pro Tools HD on an HDX hardware accelerated system, Pro Tools will use the Pro Tools Aggregate I/O as the Playback
Engine if a Core Audio application has already engaged the HDX hardware. Be sure to quit all Core Audio applications before launching
Pro Tools HD to ensure that Pro Tools HD can use HDX hardware.
With multiple track output assignments, Native plug-ins use more voices than expected (PTSW-156089)

When using Native plug-in as the last insert on a track that has multiple outputs assigned, additional voices will be used for each voiced
output assignment. This is because a voice is required for each audio channel routed from the TDM engine to the host processor and
back. To avoid this issue, use a DSP plug-in, such Trim, as the last insert on the track.

Pro Tools|HD Native PCIe Systems
Audible pops and clicks occur when changing buffer sizes (PTSW-125715)

Pops and clicks may occur when changing the Hardware Buffer Size (H/W Buffer Size) in the Playback Engine dialog while monitoring
live audio through HD Native hardware. Avid recommends not changing the Hardware Buffer Size while monitoring live audio to avoid
this problem. If you must change the Hardware Buffer Size while monitoring live audio, be sure to lower the monitoring volume to avoid
any possible damage to your speakers.

Pro Tools|HD Native Thunderbolt Systems
HD Native Thunderbolt headphone output stops working when low latency monitoring is enabled (PTSW-169936)

The headphone output on the HD Native Thunderbolt does not function when low latency monitoring is enabled. In this case, use alternative monitoring source such, as an Avid HD OMNI.
HD Native Thunderbolt prevents the computer from waking after sleep (–9171 error) (PTSW-169172)

Pro Tools HD and HD Native Thunderbolt do not support the sleep function of Mac OS X. If encountered, disconnect HD Native Thunderbolt to wake the computer. Disable all sleep functions in System Preferences (except display) and shut down the computer. Reconnect HD Native Thunderbolt and start the computer.
HD Native Thunderbolt reports a clock error at higher sample rates (PTSW-168819)

With some computers, you may encounter an audio clock error when recording at higher sample rates (such as 96 kHz) and with lower
HW Buffer Size settings (such as 128 samples or less). In general, higher HW Buffer Size settings are recommended at higher sample
rates. For example, at 96 kHz, a HW Buffer Size setting of 256 samples or higher is recommended.
HD Native Thunderbolt is only supported as the first or second thunderbolt device in a thunderbolt chain at sample rates up
to 96 kHz, and it must be the only Thunderbolt device in a chain at any sample rate above 96 kHz (PTSW-168229)

HD Native Thunderbolt is only supported as the first or second Thunderbolt device in a Thunderbolt chain at sample rates up to 96 kHz,
and must be the only thunderbolt device in a chain at any sample rate above 96 kHz. Visit the compatibility pages on the Avid website
for more information (www.avid.com/compato).
Pro Tools quits unexpectedly when selecting HD Native Thunderbolt in the Playback Engine (PTSW-167511)

After disconnecting and reconnecting HD Native Thunderbolt from your computer, Pro Tools quits unexpectedly when selecting HD
Native Thunderbolt in the Playback Engine. After disconnecting and reconnecting HD Native Thunderbolt, restart your computer to
avoid this problem.
HD Native Thunderbolt does not pass audio with some third-party applications at certain buffer sizes (PTSW-166134)

HD Native Thunderbolt only supports HW Buffer Sizes of 64, 128, 256, 512, 1024, and 2048 samples. However, some third-party applications (such as Cubase) may let you select unsupported hardware buffer sizes. If an unsupported buffer size is selected, HD Native
Thunderbolt may not pass audio. Select a supported buffer size to correct this issue.
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Using the HD Native Thunderbolt headphone output with surround monitoring (HDM-13)

Headphone monitoring with HD Native Thunderbolt is set to mirror Pro Tools output channels 1 and 2 on the first audio interface. To
use HD Native Thunderbolt headphone monitoring with sessions that use surround formats (such as 5.1),change the surround monitoring path in I/O Setup so that the Left channel is mapped to Output channel 1 and the Right channel is mapped to Output channel 2.

I/O Setup
Master Faders assigned to mapped output busses function only on that specific bus, not for the output channel as a whole
(PTSW-127517)

Because a Master Fader works on a bus, not on an output path or output channel, there may be certain configurations in which the level
sent to the physical I/O is not reflected on any meters in the Pro Tools application. If the configuration includes overlapping output paths
or has multiple busses assigned to a single output path, the overall signal level from these combined sources (including any clipping indication) will only be displayed on the interface itself. You can avoid using multiple output paths or output busses simultaneously by
routing your sources to a single mapped output bus and assign a Master Fader to that.
Overlapping outputs are not supported for AFL/PFL (PTSW-128167)

While Pro Tools I/O Setup lets you select overlapping outputs for AFL/PFL monitoring, overlapping outputs are not supported for
AFL/PFL monitoring. For example, if paths A 3–4 overlap the main path A 1–2, even though you can select paths A 3–4 for AFL/PFL
monitoring, you won’t hear anything when monitoring AFL/PFL on paths A 3–4. You can avoid this problem by using non-overlapping
paths for AFL/PFL monitoring.
Session templates retain I/O settings and some preferences, display settings, and window layouts (111605)

Pro Tools session templates retain the I/O settings and some of the preferences, display settings, and window layouts from the system
on which the template was created. Consequently, created a new session based on a template restores several session properties from the
original system. These properties are retained by Pro Tools until you change them or another session or template is opened that replaces
them. This also means that if a new blank session is created after using a template, the properties from the template will be used for the
new session.
The properties retained from templates include default track height, view settings, window size and position, and I/O Setup. You can update templates by making the desired changes, using the File > Save as Template command (be sure to select the “Install template in system” option), and then selecting the template you want to replace.
I/O Settings Pane appears inactive after editing video track during play (PTSW-183106)

If you edit video during playback, the I/O Setting pane for the Video track appears inactive during playback, preventing you from opening the track’s Output Setting tab. To access I/O settings for the track, stop playback.
Output and Send assignments may not be reactivated if they are disabled and then re-enabled in the IO Setup when DSP Usage
is at its maximum (PTSW-156397)

Disabling and re-enabling an internal or mapped bus in the IO Setup does not guarantee that all associated assignments will be re-activated in a session that is using maximum DSP resources. To re-activate these assignments, save and reopen the session. You can also
avoid this issue by adding additional HDX cards to your system.
IO Setup sets to Pro Tools Aggregate IO after updating HDX card firmware (PTSW-159624)

Pro Tools IO Setup may be improperly configured to Aggregate IO after performing a firmware update on an Avid HDX card. To resolve this issue, quit Pro Tools and delete the “Last Used.pio” file from the IO Settings folder (located in the same folder as the Pro Tools
application). Relaunching Pro Tools will create a default IO setup based on the peripherals connected to your HDX card(s).

File and Disk Management
Missing files when opening a session that was saved using Save Copy In with Preserve Folder Hierarchy (PTSW-52860)

The Preserve Folder Hierarchy feature is designed so that sessions with media split between multiple volumes can be easily moved between systems while retaining folder hierarchy. In order for media files to be automatically found, manually copy or create a folder at
the root level of each volume with the session name that contains the Audio Files or Video Files folder. Or, manually relink to the missing files at their current location.
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Session copy saved with Preserve Folder Hierarchy in which multiple files have the same name does not relink properly
(PTSW-52860)

When saving a session copy with Preserve Folder Hierarchy checked, files with the same name may not relink properly when using
Manual Relink. When opening the session copy, use Automatically Relink to locate the correct files. If the session has already been
opened using Manual Relink and some files are still offline, select Relink Offline in the Project Browser to manually relink the remaining files.
After Relinking files the Relink window does not retain its “revealed/open” status (PTSW-178130)

Although the checkbox remains selected, the reveal status of volumes is not retained if the Relink window is automatically reopened.
Be sure to reveal the volumes so that the enabled checkboxes are visible in order to reliably relink to missing files.

Elastic Audio
When opening legacy sessions (Pro Tools 9 and lower) in Pro Tools 10 and higher, any rendered Elastic Audio clips are
automatically re-rendered (PTSW-139989)

Rendered Elastic Audio clips created in legacy sessions need to be re-rendered for use in Pro Tools 10 and higher. Re-render of these
files occurs automatically when the session is opened in Pro Tools 10 and higher.
Fades on Elastic Audio-enabled tracks may not regenerate when opening sessions created with Pro Tools 10 and higher in
Pro Tools 9.0.x (PTSW-152949)

When saving a copy of a Pro Tools 10 or higher session to v7-v9 and opening the copy in Pro Tools 9.x, some fades might not be regenerated even if you select the option to re-generate fades without searching. If this happens, closing and re-opening the session causes
the missing fades to regenerate.
Certain audio files cannot be calculated or cleared of Elastic analysis in the Workspace browser (PTSW-29622)

There are some rare cases where a file will have a file suffix of a file format supported by Elastic Audio (either .WAV or .AIF), but the
Pro Tools Workspace Browser will not allow calculation or clearing of elastic analysis. The browser menu items Calculate Elastic Analysis and Clear Elastic Analysis will be greyed out. In these cases, the file may actually be in a non-supported format. To check the file’s
format, look at the Format column in the Workspace browser. If a file format other than WAV or AIFF is shown (such as QuickTime),
then the file cannot be calculated or cleared of elastic analysis. Note that these non-supported files can still be previewed in tempo, as
well as elasticized once imported into a session.
Tempo maps made from Bar|Beat marker generation in Beat Detective cause Clip Groups in rendered mode to fall offline
(PTSW-34950)

A tempo map made from Bar|Beat Marker Generation in Beat Detective will cause clip groups in Rendered mode to fall offline. The
workaround is to make an edit to the offline clip and then toggle the Elastic Audio from rendered to real-time and then back to rendered.
Maintaining phase coherency with Elastic Audio pitch processing (PTSW-20602)

When there is Elastic Audio Pitch processing enabled on a track, switching from Polyphonic, Rhythmic, or X-Form to Monophonic or
Varispeed can disrupt phase coherency. To preserve phase coherency in this case, be sure to clear all Elastic Audio Pitch processing
from the track before switching to the Monophonic or Varispeed algorithm.
Drift in an audio file may occur when using Elastic Audio and the Monophonic or X-Form algorithms (PTSW-33768)

Drift in an audio clip may occur when using elastic audio depending on how much the clips is expanded or compressed when using the
Monophonic or X-Form algorithms. If you are using elastic audio with material that contains transient information in it that you would
like to keep from drifting, you should use the Polyphonic or Rhythmic algorithms.
Default Input Gain preference is only for Elastic Audio imported at session tempo (PTSW-34096)

The Default Input Gain preference in the Elastic Audio section of the Processing Preferences page is for Elastic Audio Imported at Session Tempo only. This preference option will not function unless Preview in Context is enabled in Workspace, and/or “Drag and Drop
from Desktop Conforms To Session Tempo” is enabled in the Processing Preferences page.
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Displayed Timebase is incorrect after importing Elastic Audio tracks (PTSW-46897)

The incorrect timebase is displayed after importing Elastic Audio tracks to existing tracks with opposite timebase. You will need to manually select the correct timebase for the affected tracks.
Elastic Audio clips on playlist lanes are not rendered (PTSW-47311)

In Playlists View, any Elastic Audio clips on Playlist lanes are not rendered (waveform is “off-line”) when changing the track’s Elastic
Audio processing from Real-Time to Rendered.
Clip Groups containing Elastic Audio are not recognized as Elastic if the Clip Group itself has not had any Elastic functions
applied (PTSW-34335)

If a clip group contains Elastic Audio inside it, but no Elastic Audio operations have been performed on the outermost level of the clip
group itself, then the clip group will not register as Elastic Audio. When used to create a new track, the track will not automatically be
Elastic Audio–enabled, and the elastic audio inside the clip group will be rendered using the default Elastic Audio plug-in for the session. As a workaround, add a warp marker to the clip group to force it to register as an elastic clip. Or, create an Elastic Audio–enabled
track first, then add the clip group to it.
Cannot import Elastic Audio tracks with the Consolidate From Source Media option (PTSW-33894)

Use Copy from Source Media to import Elastic Audio tracks.
Timing inaccuracy in audio files converted from CAF and MP3 with Preview In Context enabled (PTSW-46707)

Audio files converted from CAF and MP3 with Preview In Context enabled can cause timing inaccuracies (gaps in the audio and innerclip asynchronous transients issues). This is inherent with compressed file formats.

MIDI
When recording MIDI, Wait for Note does not respond to MIDI input from ReWire (PTSW-30511 and PTSW-34550)

When performing a MIDI record, Wait for Note will not respond to any MIDI received from ReWire. If you are recording MIDI generated from a ReWire application, you will have to start the transport manually or use a countoff instead of Wait for Note.
When using Import Session Data on a MIDI track with Real-Time Properties enabled and set to using Diatonic transposition,
transposition is based on the first key signature in the session only (PTSW-49297)

When importing session data from a session that includes multiple key signatures and a MIDI or Instrument track with the “Transpose
in Key” Real-Time property enabled, the transposition will be based only on the first key in the session. This can be corrected by toggling the Real-Time Properties off and on; then the diatonic transposition will be correct for each key.

Plug-Ins
For known issues about specific plug-ins, see the Audio Plug-Ins Read Me.
When opening legacy sessions, the 4-band EQ III plug-in is converted to the 7-band EQ III plug-in

The AAX EQ III plug-in does not have a 4-band option. Pro Tools will automatically convert 4-band EQ III instances into 7-band instances if you are using only AAX plug-ins.
Custom location for Avid Virtual Instrument content is not remembered

When installing Avid Virtual Instruments, if you choose a custom location for the content, that location is not remembered, resulting in
error messages when you try to use a virtual instrument plug-in (Boom, Mini Grand, or Xpand) that references a “.big” content file. The
location is not remembered after quitting and relaunching Pro Tools.
To avoid this error, move or reinstall the Avid Virtual Instrument content to the default location.
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Some plug-ins require exclusive use of a DSP chip on HDX hardware-accelerated systems (PTSW-154614)

Certain plug-ins, such as ReVibe and Reverb One, use direct memory access (DMA) on Avid HDX cards. DMA plug-ins cannot share
HDX DSP chips with other plug-ins. Additionally, even though DMA plug-ins of the same type can share a single HDX DSP chip (for
example, multiple ReVibe plug-ins can use the same HDX DSP chip), they must be of the same channel width (DMA plug-ins of the
same type cannot share the same HDX DSP chip if they have different channel widths).
Native plug-ins appear unavailable at higher sample rates (such as 192 kHz) (PTSW-160300)

When using some native (host-based) plug-ins at higher sample rates (such as 192 kHz), it may be necessary to lower the number of host
processors in the Playback Engine dialog. This is because in certain situations it is beneficial to leave a CPU Core processor available
for other tasks, and not have the host-processor engine running on all Cores.
Pro Tools stops working when opening a session with Structure Free (PTSW-131965)

When opening a Pro Tools session that uses Structure Free, Pro Tools may hang temporarily if Structure Free is looking for files in a
directory where the files are not present.
With HDX systems, on tracks that have a mono-to-stereo plug-in, if a stereo native (AAX) plug-in is inserted after the mono-tostereo plug-in, the resulting stereo signal will be out of phase or diminished in volume. (PTSW-161487)

To avoid this, use a stereo DSP plug-in after the mono-to-stereo plug-in, or reconfigure the track to avoid this signal configuration.
AudioSuite and Clip Groups (PTSW-57457)

AudioSuite plug-ins handle Clip Groups in the Clip List slightly differently than audio files. With audio files, an AudioSuite process can
be applied to all copies of a unique audio file which appear in your session by selecting your target as Clip List in the AudioSuite plugin window and selecting Use in Playlist. However, if your target is set to Clip List in the AudioSuite plug-in window while you have a
Clip Group selected, Pro Tools does not recognize the Clip Group as processable audio and will present a No Audio was Selected error.
This is because a Clip Group is not treated as audio until it is actually used in a track.
To apply an AudioSuite process to all copies of a Clip Group in a session at once, do the following:
1

Select the Clip Group to be processed.

2

From the Clip List menu, select Ungroup All. All elements of the group will remain selected.

3

Perform AudioSuite processing.

4

From the Clip List menu, select Regroup.

5

When prompted, select Modify to apply the AudioSuite Process to all copies of the Clip Group in the session, or Copy to apply it only
to the selected Clip Group.

Plug-In Find and Relink with file types not supported by Pro Tools (111704)

Find and Relink will not be triggered by plug-ins in situations where plug-ins supporting Find and Relink are missing links to file types
that are not natively supported by Pro Tools (such as REX files). To have full Plug-in Find and Relink support, the file types used in
plug-ins must also be supported by Pro Tools.
Software instrument does not emit sound when inserted on an Instrument Track or Auxiliary Input (65797)

Some older software instruments do not emit sound and/or do not play unless they have a valid hardware input or MIDI output assignment. If this problem occurs, manually assign a hardware input to the Instrument track or Auxiliary Input, and/or manually assign a
MIDI output to the Instrument.
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Control Surfaces
Trim Scrub and Trim Shuttle don’t work on clips with fades (PTSW-46911)

If a clip has fades, Trim Scrub and Trim Shuttle don’t work when trying to trim using a control surface. To work around this problem,
remove any fades on the clip, then execute the Trim Scrub or Trim Shuttle, and then restore the fades.
Used HW output path indication (101095)

In Assign Matrix on your control surface, Insert mode the used HW output path will not have amber background indicating that it's already assigned after switching to a different insert on the same track.
Color indication on plug-in controls in Learn mode (102710)

When a plug-in is in Learn mode and the track with this plug-in is not focused on the main ICON unit, all automation LEDs in the Plugin window will be red if the track is in one of auto write modes. This conflicts with red color indication on the Plug-in control, which
is armed for mapping. The workaround is to set the track with plug-ins to Read automation mode.
SignalTools meter ballistics on control surfaces (74340)

SignalTools RMS, VU, BBC, Nordic and DIN meters will display inaccurate decay times when viewed on a control surface. Unaffected
types are Peak, VENUE, and Peak + RMS, which only reports the Peak meter to the control surface. The attack times of the affected meters are not affected, only the decay times. All meter types display accurately in the plug-in window.
Channel Strip plug-in Expander/Gate meters appear in the Compressor/Limiter meter Instead of in the Expander/Gate meter in
D-Control Dynamics section (Main Unit) (PTSW-150897)

The Avid Channel Strip plug-in uses shared meters for Expander/Gate and Compressor/Limiter processing. Because of this, both Expander/Gate and Compressor/Limiter metering appear only in the Compressor/Limiter meter in D-Control Dynamics Section (Main
Unit).
Pro Tools transport must be stopped when recalibrating ICON faders (78074)

The transport in Pro Tools must be stopped when recalibrating faders on D-Command and D-Control. If one or more faders need calibration do the following: Stop playback, enter Utility mode, press TEST, press FADER, and press RECAL. After recalibrating faders.
exit Utility mode.
Adjusting Clip Gain with the Jog Wheel on a EUCON control surface can result in Pro Tools quitting unexpectedly
(PTSW-155028)

Adjusting Clip Gain using the Jog Wheel on a EUCON control surface during playback can result in Pro Tools quitting unexpectedly.
You can avoid this issue by using the mouse or key commands to adjust clip gain instead.

Video
Playback of QuickTime video in Pro Tools may stutter or drop frames

When monitoring QuickTime playback in the Pro Tools Video Window on the computer screen, the video image may stutter or drop
frames. To improve results with QuickTime playback, try any of the following:
• Disable Continuous Scrolling.
• Close unnecessary UI windows.
• Try using the DNxHD codec.
• A second Pro Tools, Media Composer, or Symphony DX Video Satellite option offers guaranteed performance for Avid video playback with a primary Pro Tools|HDX or Pro Tools|HD Native system.
H.264 video files over 2 GB play back incorrectly (PTSW-158646)

At a certain point during playback, an H.264 video file over 2GB in size will incorrectly restart playback from the beginning, even
though the timeline indicates it is not playing from the beginning. The workaround is to place an edit (break) in the video clip prior to
the point it starts playing incorrectly from the beginning. This issue only affects H.264 files larger than 2GB.
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Video clip does not playback and shows only black when placed 12 hours or more from session start (crossing the “midnight”
threshold) (PTSW-184316)

Video clips show only black when placed 12 hours or more from session start, which also crosses the “midnight” threshold. Video clips
placed after the timecode position 00:00:00:00, in sessions with starting timecode values greater than 00:00:00:00 may result in only
black displaying to the video outputs at those locations. Make sure that you do not place video clips past the midnight threshold.
No checkmark next to DNxHD video clips in the Clips List (UME-820)

DNxHD files that contain an Alpha channel will not run in an optimized performance mode. Because of this, there will be no check mark
next to these files in the Clips List or on video clips in the Edit window when choosing to view Processing State. For optimized playback
of DNxHD QuickTime, transcode the file without an Alpha channel using the Pro Tools Bounce to QuickTime command or using a
third-party application.
Playback of PhotoJPEG-encoded video experiences dropped frames or stuttering (PTSW-183056)

PhotoJPEG is not a preferred CODEC for video playback in Pro Tools. It you experience performance issues with this CODEC, please
transcode to a preferred Avid CODEC, such as DNxHD or DV25. This can be done by bouncing the file to QuickTime from within Pro
Tools and choosing the “Advanced Settings” in the bounce window.
Video pull factor may become invalid when video hardware is enabled (PTSW-180554)

If a software video pull factor of 0.1% is set while video hardware is disabled, enabling the video hardware may create an illegal pull
setting. Video hardware only supports 0.1% pull ups at 24pPAL rates, and 0.1% pull downs at 25pPAL rates. If the pull rate is set to
0.1% at any other rate while video hardware is enabled, manually select an available option from the pull menu, which may be “none.”
Video pull settings menu lists spurious information (PTSW-181178)

The Video Pull Settings menu lists both a pull factor (in percent) and an implied video format transition (bracketed text), which is an
artifact of the Audio Pull Settings menu. The pull factors are correct and the bracketed text can be ignored.
The Project Type does not change to reflect the new project rate after a pull factor is applied to video (PTSW-179896)

When video is pulled, the Project Type selector does not change to match the resulting project rate. This is because the fundamental rate
of the project does not change. The Avid Video Engine continues to reference the fundamental rate while applying the selected pull factor.
“Synchronization error, aborting play” when looping video playback for longer than 90 minutes with Mojo DX or Nitris DX
hardware (UME-778)

When looping video playback for longer than 90 minutes using an Avid Mojo DX or Nitris DX video peripheral, you may encounter a
“Synchronization error, aborting play” message. Restart playback to recover from this error.
Legacy Extended video playback from Pro Tools may become choppy when DX video hardware is attached (UME-783)

After continuous playback of video for longer than 90 minutes with DX hardware, video may become choppy. To fix this, stop and restart video playback in Pro Tools.
Video may not stay in sync when video hardware is attached and Pro Tools is locked to an external clock (PTSW-178722)

If both Pro Tools and an attached video peripheral are each resolved to an external clock, but the clock is not derived from the same
source, video will not stay in sync. An example of this would be if the video peripheral is locked to black burst, and the audio peripheral
is locked to an audio clock not derived from the same video black burst, such as SPDIF. In this scenario, setting the video peripheral to
lock to its own internal clock will allow Pro Tools to compensate for video drift over time.
Closing the QuickTime window during session playback may result in –9092 errors that stop playback

To avoid this issue, try increasing the number of CPU Cores available for Pro Tools processing and/or raise the H/W Buffer Size in the
Pro Tools Playback Engine dialog.
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Pro Tools UI may slow down with densely-edited QuickTime Movie track (PTSW-54496)

Pro Tools may begin to respond more slowly and update less often as a session with one or more QuickTime video tracks becomes more
and more densely edited. If, while working with heavily edited QuickTime clips, Pro Tools responsiveness begins to decline, use the
Bounce to QuickTime Video command, then import the bounced movie.
Unsupported QuickTime video formats (PTSW-52140, PTSW-52155, PTSW-52156, PTSW-53625, 72961)

Several video formats supported in QuickTime are not supported in Pro Tools. These include .DivX, .flc, .m4v and .3gp format movies.
Attempting to import these will generate errors or will fail to import.
QuickTime files that contain multiple CODECs may not import (UME-835)

If the Pro Tools tells you that a file cannot be imported because it may be unsupported, check to see if the file contains more than one
CODEC. This can be done by opening the file in QuickTime player and examining the file properties. QuickTime files that contain more
than one CODEC are not officially supported for import into Pro Tools.
Non-standard sized video clips may open at unintended Video Project Rates (PTSW-180726)

Non-standard sized video clips may open at unintended Video Project Rates when imported into your Pro Tools session. To avoid this
issue, import them while pressing the Command key (Mac) or the Control key (Windows) to be able to choose any Video Project Type.
“Error reading video in the QuickTime files” when importing some MPEG 1 and 2 video files in Pro Tools (PTSW-178017)

Some MPEG1 and MPEG2 files cannot be opened by Avid applications, including Pro Tools. Transcode these files to one of our primary CODEC such as DNxHD or AppleProRes for use in Pro Tools to avoid this issue.
MPEG-1 and MPEG-2 video freezes at edit points (PTSW-55185)

Editing MPEG-1 & MPEG-2 video is not officially supported. If you experience this problem, try switching playback to the Video window, or convert the movie to a supported format using a 3rd party application. Removing the audio from an MPEG-1 or MPEG-2 movie
with a 3rd party application may also fix the problem.
3G2 file extension is not supported for video import (PTSW-183056)

Pro Tools 11 provides support for the .3GP file type extension for video import. These are video files often created on mobile phones.
The second generation of this format uses the file extension of .3G2. Files with the .3G2 file extension will be filtered out as unavailable
for video import. These .3G2 files may be available for import if their file extension manually changed to .3GP. If the files remain unavailable for import after changing their extension, they will need to be converted to an explicitly supported format such as DNxHD or
AppleProRes for use in Pro Tools.
System instability when running multiple applications using Blackmagic Design hardware for QuickTime video output
(PTSW-19486)

When Pro Tools is running with a Blackmagic DeckLink II Extreme or Intensity video capture and playback PCI-e card installed,
launching Blackmagic Design’s Deck Capture utility, Final Cut Studio, or any other application which supports Black Magic hardware
for video output, can result in system instability. To avoid any potential system instability only use one Blackmagic DeckLink–aware
application at a time.
Clip names appear incorrect after selecting Field Recorder channel matches, or expanding to new tracks. (PTSW-136012)

This can occur if the file name of a Field Recorder channel match contains a hyphen followed by a number greater than zero. Pro Tools
names new clips by incrementing the number after the hyphen. If a field recorder file is already named in this way (such as “Filename01”), then new clips created by selecting a Field Recorder channel match or by expanding a track may have names different from the
parent file. To avoid this situation, avoid using hyphens in Field Recorder file names.
Field Recorder matches appear offset after AudioSuite rendering if the session timecode rate does not match the file timecode
rate (PTSW-152147)

If a portion of a file has been rendered with an AudioSuite plug-in, an offset can occur when expanding field recorder matches in cases
where the session timecode rate does not match the timecode rate of the audio file. To avoid this issue, you can either render the whole
file with AudioSuite (rather than only a portion of the file), or use Whole File mode when rendering AudioSuite processing.
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External Field Recorder matches do not show up after an initial index pass (PTSW-180659)

If external field recorder matches do not show up on a field recorder track after the initial index pass, save and reopen the session.

Third-Party Video Peripherals
The following issues may occur with third-party video hardware. Please contact your hardware vendor for support.
In some cases, video will not stay in sync over time if the video peripheral is not, or cannot, lock to video reference. If you experience
this, a workaround is to set the Pro Tools clock to internal. This will cause the video peripheral to slew overtime and stay in sync with
Pro Tools. (THPV-2)



Some video peripherals will scramble output when Pro Tools video thumbnails are drawing. To avoid this, set the Video track to
Blocks view. (THPV-8)





With some peripherals video playback will be one frame out of sync with Pro Tools audio. To compensate for this, choose Setup >

Video Sync Offset and enter a 1 frame offset. (THPV-9)
 With some video peripherals, desktop video will be offset by 1–2 frames when the video peripheral is active. This can be fixed by
disabling the hardware from Options > Disable Video Hardware, or alternatively this can be compensated for using Setup > Video Sync
Offset. (THPV-10)

Some video peripherals will lose AV Sync when playback is attempted from a 9-pin controller when linked with other Pro Tools or
Media Composer Satellites. To avoid this issue, attach the 9-pin controller to a Pro Tools Satellite that does not have a third-party video
peripheral attached. (THPV-11)





Some video peripherals will not update the video display to the correct location when the Pro Tools transport stops. (THPV-12)

 With some video peripherals, the video output will be scrambled when video is not loaded in Pro Tools, or when the video peripheral
is disabled. (THPV-13)

Satellite Link
The Administrator may appear grayed out and unavailable on Administrator system in the Satellite page in the Peripherals
dialog (PTSW-181483)

The Administrator system may appear to be unavailable in the list of available Satellites as displayed by the Administrator’s Satellite
system in the Satellite page in the Peripherals dialog. Should this happen, toggle the Satellite Mode to Satellite from Administrator and
back to reset it.

Video Satellite
Linking Video Satellite and Satellite Link (Item #109199)

When trying to link to a the Media Composer system in a Satellite Link configuration with Video Satellite configuration, you cannot link
from any Pro Tools Satellite system. You will need to link from the Media Composer or the Pro Tools administrator system.
Video Satellite Doesn't Support Loop Playback when Selection is Less than One Second (Item #93743)

When looping playback with Video Satellite, if the selection is less than one second, playback may stop after a few loops or Media Composer may post a “Pro Tools cannot currently play” dialog. The workaround is to make a selection that is 1 second or longer.
Pro Tools and Media Composer Video Satellite Quit Unexpectedly when Disconnecting an Additional Pro Tools System During
Playback (Item #110601 and UDevC00115566)

When multiple Pro Tools systems are connected via Satellite Link in conjunction with a Video Satellite, always stop playback before
disconnecting any of the systems.
Media Composer 6.5 Video Satellite not seen by Pro Tools (PTSW-183505)

Media Composer 6.5 does not appear as a Video Satellite when used with Pro Tools 11. A Media Composer 6.5.x patch is required to
run Media Composer with Pro Tools 11 in this configuration. Visit www.avid.com for Media Composer 6.5 updates.
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“Pro Tools Cannot Currently Play” Error (Item #UDevC00116083)

In a Video Satellite configuration, when the system is sitting idle, Media Composer may post the dialog, “Pro Tools cannot currently
play, is online with Machine Control, or is in Transport = Remote Mode. Please resolve the issue with the Pro Tools system and try
again.” To avoid this problem, link the Video Satellite from the Pro Tools Administrator system rather than from Media Composer.
Audio Energy Plot Disappears in Media Composer when Video Satellite Playback is Stopped (Item #UDevC00115392)

If the Audio Energy Plot disappears in Media Composer when Video Satellite playback is stopped, minimize Media Composer to force
a redraw.
An Exception Error Occurs when Launching Media Composer (Item #UDevC00115632)

An exception error occurs when launching Media Composer or enabling Video Satellite mode in Media Composer if there is no valid
network card in the system, or if the network card is disabled. If this happens, quit Media Composer and enable or install a valid network
card. Video Satellite requires a network connection. If you are not using Video Satellite, disable Video Satellite mode in Media Composer’s Video Satellite setting.
Clips on Satellite Track Don’t Move when Changing the Session Start Time in Pro Tools (Item #105387)

When changing session start time in Pro Tools, clips on a satellite track do not move when “Maintain Time Code” is selected, or when
undoing a previous session start time change. You will need to move the clips on the Satellite track manually.
23.976 or 24 fps Sequence Start Time Ending In Digits Other than “:00” Causes Time Code Offset

Media Composer uses NTSC or PAL time code when setting the sequence start time regardless of the format selected by the user for
display. When you are working on a video satellite project at 23.976 or 24 fps, a Media Composer sequence with a start time that ends
in a value other than :00 causes an offset between Pro Tools and Media Composer at the session start. For example, the start time
45:02:10:15 (ending in :15) would cause an offset, but the start time 45:02:10:00 (ending in :00) would not.
As a workaround, always set your Media Composer sequence start time to a time code value ending in 00.
Cueing from Media Composer in a 720p Project Causes 1-Frame Offset (Item # 98460)

In 720p projects, Media Composer counts at 50 or 60 (59.94) progressive fps—depending on the project type—while Pro Tools counts
at 25 or 29.97 frames per second. When you cue a sequence from the video satellite in a 720p project, the Pro Tools edit cursor can be
offset by as much as one frame.
As a workaround, cue and play back from Pro Tools when working with a 720p project in a video satellite system. This ensures that the
two applications are always in sync. It is not possible to cue to odd 50 or 60 frame boundaries (for example, frame 47) from Pro Tools.
29.97 Digital Cut Output Format in 23.976 and 24p Projects Causes Media Composer to Play Faster Than Pro Tools (Item #
UDevC00082004)

When you are working with a 23.976 or 24p project in a video satellite, setting the Digital Cut Output Format to 29.97 causes
Media Composer to play 25% faster than Pro Tools. This setting is intended for video-only transfers.
As a workaround, unlink Media Composer from Pro Tools during the digital cut. Note that appropriate Output Format setting for broadcast masters is 23.976.
Playing a Complex HD sequence with SD Down-Convert Enabled Causes Synchronization Error (Item # UDevC00091109)

If you down-convert a complex HD sequence in real-time while playing back a video satellite sequence in DNA mode, Media Composer
may abort play and post the following message: “Synchronization error. Aborting play.”
As a workaround, do one of the following:
• Switch the project back to HD format and use 1394 mode to play back.
• Create a video mixdown of the sequence.
• Transcode the media to SD before playing back.
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Audio and Video May Drift Out of Sync In Satellite Mode in Certain Conditions (Items # UDevC00090064, UDevC00090078,
UDevC00088666, UDevC00089437, UDevC00087542)

When operating in Satellite mode, audio and video output from Media Composer may drift out of sync by as much as one frame in any
of the following conditions:
• When monitoring video in 1394 mode via full screen playback. This is due to the difference between the monitor's refresh rate and
the video reference rate.
• When the Edit Play Rate of the video differs from the frame rate of the video reference signal. (For example, this occurs with a 24p
NTSC project with 23.976 Edit Play Rate and NTSC reference signal.)
• When looping a selection that is not aligned to video frame boundaries in Pro Tools. As a workaround, make your selection in
Pro Tools using Grid mode with the Grid value set to 1-frame increments—especially when it is necessary to loop several times without stopping.
Media Composer Export Including Copied or Consolidated Media to a Location Other than the Pro Tools Session Folder
Prevents Pro Tools from Automatically Locating Media Files (Item # UDevC00056745)

When you export an AAF or OMF sequence from a video satellite using the Copy All Media or Consolidate Media option, make sure
to save media files to the root level of the Pro Tools session folder. This ensures automatic relinking of media when you import the AAF
or OMF sequence into Pro Tools. Also, if you export a sequence from the video satellite with the audio storage mounted on the satellite
system, save the AAF or OMF to the root level of the Pro Tools session folder, and choose Folder, then choose Use Same Folder as
AAF/OMF file when exporting the sequence.
If the Avid MediaFiles or OMFI MediaFiles folder is located somewhere other than the root folder of the destination Pro Tools session,
Pro Tools cannot automatically relink to the media. If you did not export the sequence to the Pro Tools session folder as described
above, you can do either of the following as a workaround:
• Re-export the AAF or OMF sequence from the video satellite as described above.
• Use Pro Tools to manually search for the media by Name and Unique ID.

Avid Interplay
Unable connect to Interplay server by entering its IP address (PTSW-173106)

With Interplay Access, when importing a sequence from Avid Interplay into Pro Tools, if you try to connect to an Interplay server by
entering its IP address, an error message is displayed and the connection fails. To connect to the Interplay server, enter its server name
instead of its IP Address.

General Localization
Session notes or Session Info text files saved in Japanese may not open in TextEdit (PTSW-46686)

Session Notes (you can generate these if you are missing plug-ins or have problems when opening a session) or Session Info (File > Export > Session Info as Text) text files may not open in TextEdit, depending on the TextEdit preference settings. This is because the files
use different text encoding. As a workaround, you can use the Console application to open files or you can use the Open menu item in
TextEdit, then choose the correct encoding, as follows:
• Session Notes - UTF-8
• Session Info - Japanese (Mac OS)
Reading session notes on Korean Mac OS X (PTSW-144218)

Apple has changed its default UTF-8 encoding behavior in the latter 10.6.x releases and 10.7.x. Because of this some languages do not
open Session Notes correctly in TextEdit.
To open Session Notes correctly:
1

Launch TextEdit.

2

Choose TextEdit > Preferences.

3

Click Open and Save.

Pro Tools 11.0.2 and Pro Tools HD 11.0.2 on Mac OS X 10.8.x — 9/11/13

19

4

Under “Plain Text File Encoding,” set Opening Files to Unicode (UTF-8).

Certain Chinese characters need to be initiated in the Mac OS before they can be used for naming in Pro Tools (PTSW-33074)

If you cannot use certain characters for naming in Pro Tools, use Text Edit in Mac OS X to initiate the characters. In Text Edit, type the
same characters you were trying to use, then use the mouse to select the correct ones from the pop up menu. You should now be able
to use them in Pro Tools.
AAF/OMF sequences with non-English characters import with garbled clip names or won't relink (PTSW-33569, PTSW-99570,
PTSW-33826)

If an AAF/OMF sequence containing files or clip names with non-English characters is exported from a Mac-based Pro Tools 7.3.1 system (or lower), it may not import correctly into Avid Media Composer, or Pro Tools 7.4 and higher systems on Windows or Mac. Conversely, AAF/OMF sequences with non-English characters exported from any Pro Tools 7.4 or higher system (or higher) may not import
correctly into a Mac-based Pro Tools 7.3.1 (or lower) system. To relink the files, select “Manually Find and Relink,” then deselect all
options except “Find by file ID.” Clip names may appear garbled.

Known Issues with Pro Tools CoreAudio Hardware Drivers
Limitations of the Avid CoreAudio driver with CoreAudio Manager

The 003 systems have the following limitations:
Pro Tools HD and Pro Tools with 003 systems require exclusive access to Pro Tools hardware. You cannot use CoreAudio applications
and Pro Tools with these systems at the same time. To use Pro Tools, make sure you quit any CoreAudio applications before launching
Pro Tools on these systems. To use a CoreAudio application with these systems, make sure you quit Pro Tools before starting the
CoreAudio application.
 The Digi CoreAudio Driver cannot be used to preview sound files from the Mac Finder while Pro Tools is running. When a sound
file is located in the Mac OS X navigation window, a QuickTime transport bar is displayed next to it. The QuickTime transport bar lets
you audition the sound file. With USB audio interfaces, you can preview sound files from the Mac Finder as long as Pro Tools is not running. Regardless, with FireWire and Avid HD audio interfaces, the sound will always play back though the Mac built-in audio controller
(through the Mac speaker or headphone jack). However, if you double-click a sound file, the QuickTime application will launch, which
can use the Digi CoreAudio Driver for playback.

The CoreAudio Driver cannot be used for playback of Mac System Sounds.
Selecting “Digidesign HW” for Sound Input or Output in System Preferences may cause Pro Tools to fail to launch (99576)

If “Digidesign HW” is selected as the input or output device in System Preferences, certain common actions in the Finder may activate
the CoreAudio Manager. These actions include selecting an audio or video file while in Columns view or while the Inspector window
is open, or using Get Info or Quick Look on an audio or video file. Once activated, CoreAudio may remain connected even after selecting a different file or closing all Finder windows. If Pro Tools is launched while CoreAudio is connected, an error message stating
“Hardware is in use by another application. (–1133)” may occur.
Pops when changing sample rates

With the CoreAudio Manager, your Pro Tools hardware may produce a “pop” or “click” sound if Pro Tools was last used at a sample
rate different from the one the new CoreAudio client is set to use.
Audio streaming problems when using very low H/W Buffer Sizes with 3rd party Core Audio applications (such as Logic)
(PTSW-154719)

You may experience audio streaming problems when using Avid hardware with 3rd party applications such as Cubase or Logic and
playing back at the lowest buffer size. The lowest supported buffer sizes when using Avid hardware are 64 at 44.1 and 48 kHz sessions,
and 128 at 88.1 and 96 kHz.
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Buffer sizes incompatible with Pro Tools hardware (39542)

In Cubase, Traktor, Live, and certain other applications, you can select Buffer Sizes that may be incompatible with your Pro Tools hardware. Selecting incompatible buffer sizes results in distorted sound and may cause other problems. Please make sure to select Buffer
Sizes listed in the following chart:
Cubase SX Buffer Sizes Supported by Avid Audio Hardware
Avid Audio Hardware

Supported Buffer Sizes

Avid HDX

128, 256, 512, 1024

HD Native

128, 256, 512, 1024

003, 003 Rack, 003 Rack+, Eleven Rack

64, 128, 256, 512, 1024

Mbox and Mbox 2-series interfaces

32, 64, 128, 256, 512, 1024

Reason Output distorts with Buffer Size settings less than 256 samples at 88.2 kHz or 96 kHz (39399)

Distorted sound can result when a Reason user has selected a Buffer Size of less than 256 samples at sample rates of 88.2 kHz or 96 kHz.
Pro Tools reports a –6101 error connecting or disconnecting headphones or audio cables from the audio output jack on your
computer while using Pro Tools (PTSW-159325)

You may encounter a –6101 error when connecting or disconnecting headphones or audio cables from the audio output jack on your
computer while using Pro Tools. To avoid this problem, quit Pro Tools before connecting or disconnecting your headphones or audio
cables.

Known Issues with Audio Interfaces
HD OMNI
Noise in the output signal from HD OMNI with digital input (PTSW-1614)

If HD OMNI is connected to a digital source with a mismatched clock and Sample Rate Conversion (SRC) is not enabled, you will hear
noise (including loud “pops”) in the output signal. To correct this problem, either enable SRC or ensure that the clock of the digital
source and HD OMNI are matched correctly.
HD OMNI front panel Setup menus are unresponsive after Pro Tools quits unexpectedly (PTSW-125692)

HD OMNI will not automatically recover “stand-alone” mode if Pro Tools quits unexpectedly (or if you disconnect the DigiLink cable
from HD OMNI while Pro Tools is running). As a result, some of the SETUP functions accessible from the front panel will be unavailable. Power cycle HD OMNI to recover stand-alone mode.
Graphic redraw problems in the Hardware Setup dialog (PTSW-122690, PTSW-1346, and PTSW-1235)

When changing the Hardware Setup configuration for HD OMNI, it is possible to encounter graphics redraw problems in some cases.
To force a graphics redraw of the Hardware Setup dialog, close and reopen the Hardware Setup dialog.
No sound on output after hardware reset (PTSW-126575)

After resetting the HD OMNI interface to the default factory settings using the front panel controls, the HD OMNI interface stops emitting sound in sessions where the outputs are not assigned to the Monitor output path. To correct this problem, press the ALT monitor
button to switch to the ALT Monitor path, and then press it again to switch back to the Main Monitor path.
Loss of Monitor path when launching Pro Tools with HD OMNI off or disconnected (PTSW-127313)

When launching Pro Tools and opening I/O Setup after powering off HD OMNI or disconnecting it from the system, the inactive Monitor path is not present in Output tab. You may need to restore the default I/O Settings and remap the corresponding Output Busses.
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Output paths are not automatically created in the Output page of the I/O Setup after disabling the corresponding Monitor path
in the Monitor page of the Hardware Setup and re-assigning the Outputs from “None” to physical outputs in the Main page of
the Hardware Setup (PTSW-127559)

After disabling the Monitor path in the Monitor page of the Hardware Setup and re-assigning the corresponding Outputs from “None”
to physical outputs (such as “A 1-2”) in the Main Page of the Hardware Setup, these Output paths are not automatically created in the
Output Page of the I/O Setup. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
Changing Monitor path Output assignments in the Hardware Setup does not update the Output paths in the Output page of the
I/O Setup (PTSW-127563)

When changing Monitor path Output assignments in the Monitor page of the Hardware Setup (such as setting the Monitor path Format
to None or assigning the Monitor to different physical outputs), the Output paths in the Output page of the I/O Setup do not reflect the
corresponding changes. You will have to manually create the appropriate Output paths in the I/O Setup (or click Default).
When creating new sessions, using the I/O Settings selector can result in unexpected Output assignments if HD OMNI has an
assigned Monitor path (PTSW-123896)

If HD OMNI has an assigned Monitor path, Output paths created by the selected I/O Settings option in the New Session dialog may be
offset by the channel width of the Monitor path. If this happens, you will have to manually create the appropriate Output paths in the
I/O Setup (or click Default).
I/O Setup Bus page erroneously adds monitor paths (PTSW-127739)

With both MAIN and ALT Monitor paths declared, toggling one of the CR Monitor paths from the current format to “None” and then
back to the starting Monitor format from within the Hardware Setup Monitor page, causes the Bus page in I/O Setup to erroneously add
an extra Monitor path with the abbreviation with “(1).” This can happen numerous time and each new Monitor abbreviation increments
accordingly.

003 Series Interfaces
Reconnecting an 003 after losing the connection with Pro Tools (PTSW-20351)

If your 003 series interface looses its connection with Pro Tools, increasing your buffer size may bring the device back online without
having to close Pro Tools or restart your computer.
Importing .PIM Files on an 003 System with a C|24 (PTSW-46401)

When importing a custom map .PIM file created on a 003 to another 003 system with a C|24, 003 displays “<No Track>” on the scribble
strips instead of staying in Plug-in Edit mode with a restored newly imported Plug-in Map. You will need to switch to another mode on
003 and then re-enter Plug-in Edit mode to correct this.

Pro Tools Aggregate I/O (Mac Built-In Audio)
–6101 error when previewing audio with Pro Tools Aggregate I/O (PTSW-132996)

When previewing audio in the Import Audio dialog with Pro Tools Aggregate I/O selected as the Current Engine (in the Playback Engine dialog), and with the Mac OS File view is set to Columns view, you may encounter a –6101 error. Try changing the Mac OS file
view from Columns to List or Icons view, or use any of the built-in audio devices instead of Pro Tools Aggregate I/O to avoid this problem.
Changing sample rates in Audio MIDI Setup can cause Aggregate I/O to disappear in I/O Setup, resulting no audio output
(PTSW-132281)

When Pro Tools Aggregate I/O is selected as the Current Engine in the Playback Engine dialog, changing sample rates in Audio MIDI
Setup can cause the Pro Tools Aggregate I/O to be removed from I/O Setup resulting in no audio output. To correct this problem, click
the Default button on the Output page of the I/O Setup.
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Error messages when opening a session with a different sample rate from the Aggregate I/O sample rate setting (PTSW-131779)

Pro Tools may indicate that a given Aggregate I/O device has not automatically adjusted its sample rate when a session with a different
sample rate is opened. You may subsequently be presented with a dialog indicating that the session needs to be closed and reopened to
update the sample rate setting of the Aggregate I/O device.
Renaming Pro Tools Aggregate I/O driver in AMS corrupts the driver (PTSW-131383)

If you rename the Pro Tools Aggregate I/O driver in Audio MIDI Setup (AMS), the driver be corrupted the next time you launch Pro
Tools. If this happens, quit Pro Tools and delete the Pro Tools Aggregate I/O device from AMS. Pro Tools will re-create the driver the
next time it is launched.
Pro Tools quits unexpectedly when enabling the built-in digital I/O (PTSW-132189)

When enabling built-in digital I/O for Pro Tools Aggregate I/O in Audio MIDI Setup, Pro Tools quits unexpectedly. To avoid this problem, enable the built-in digital I/O in Audio MIDI Setup before launching Pro Tools.

Third-Party Core Audio Devices
Using low buffer sizes with Studio Monitor Express may result in Pro Tools quitting unexpectedly with a loud burst of noise
(PTSW-132513)

Using Studio Monitor Express with some Core Audio Devices may result in Pro Tools quitting unexpectedly along with loud bursts of
noise. Studio Monitor Express is not recommend for use with Pro Tools at this time.
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Error Messages
Error –1150 (PTSW-144422)

When launching Pro Tools HD on HDX hardware, if you encounter a –1150 error, quit Pro Tools, shut down your computer, and ensure
that the HDX TDM cable is properly connected.
Error –6042

If you repeatedly encounter –6042 errors, open the System Usage window and check the PCI gauge. If the gauge is peaked, you will
need to reset the PCI bus. To reset the PCI bus, make all tracks inactive and start playback. If you still encounter a –6042 error, quit and
relaunch Pro Tools, open the Playback Engine dialog, and change the Number of Voices setting to use fewer voices per DSP.
Error –9073 without reaching the 2 GB file limit

If you encounter a –9073 error, and you have not reached the 2 GB file size limit, please refer to the Knowledge Base for possible causes
and solutions (www.avid.com/onlinesupport).
Error –9128

In sessions with high sample rates (96 kHz or higher), you may need to set the Hardware Buffer Size to 512 or more to avoid –9128 errors during playback with Native plug-ins or dense automation.
Error –9131 (92747, 20843)

GUID partitioned drives will not allow you to record beyond the third partition when running on OS X. A workaround is to partition audio drives using Apple Partition Map instead of GUID.
– or –
Recording to or playing from a UNIX File System (UFS) formatted drive is not supported in Pro Tools.
Error –9132 (32397)

If a –9132 error occurs during Bounce To Disk (even with the highest Hardware Buffer setting selected), bus the appropriate tracks to
the appropriate number and format of audio tracks, and record to disk. You can then use the resulting audio files as you would have used
bounced files.
Error –9155

In sessions with high sample rates of 96 kHz or more, you may need to set the Hardware Buffer Size to 512 or more to avoid –9155 errors during playback with dense automation.
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